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OVERVIEW

Your compact, lightweight wireless mobile bubble ink-jet printer uses with a high-quality 3-colour print 
cartridge to print borderless photographs in very high photo quality on photo or plain paper. With the 
possibility of being operated with rechargeable batteries, and equipped with a wireless Bluetooth 
interface, this printer becomes an inseparable companion during your moments of leisure.

You can enjoy your printer in the convenient PC-free or stand-alone mode, whereby you can print A6 
size photographs by plugging your PictBridge,  DPOF, or non-PictBridge/DPOF digital camera directly 
into the printer’s USB interface without needing to connect the printer to a computer or even turn the 
computer on. You can also insert your memory cards into the related slots on the printer, select and 
directly print the photos that are stored in them. Furthermore you can print straight from your wireless 
Bluetooth PC or mobile phone via the printer’s integrated Bluetooth interface.

You can also enjoy your printer connected to a personal computer via the printer’s second USB 
interface. In this way, you can also work in the same way as in the PC-free mode but also take full 
advantage of the document management and bundled software provided on the "Installation" CD-
ROM that came with the product.
note: If you want to connect your printer to a personal computer, the computer must be running the 
Microsoft Windows 98, SE, Me, 2000 or XP operating system, or MAC OS 10.3 or later.
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SAFETY INSTRUCTIONS

Carefully read and follow the information indicated below:
• Connect the power cord to an electrical outlet that is near the product and easily accessible.
• Do not use your printer near water, or with wet hands.
• Do not expose your printer to rain or moisture.
• Do not attempt to disassemble your printer. 
• Observe all warnings and instructions marked on your printer.
• Read and understand all the documentation that came with your printer.

INFORMATION ABOUT PRINT QUALITY AND THE WARRANTY

To guarantee the correct operation of your printer and top quality printing, it is essential to use only 
Olivetti original ink cartridges.

Olivetti declines any responsibility for damage to your printer caused by the tampering with, or refilling 
of, the ink-jet cartridges. Such actions also imply forfeiture of the Warranty.
GETTING STARTED 3
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LOCATING YOUR PRINTER’S COMPONENTS 
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Reference Part Description

1 Control panel Features the colour display, Bluetooth activity indicator, error LEDs 
and a number of buttons and indicators that allow you to print 
and customize print jobs. See "Printer Control Panel" for a 
description of the functions available.

2 USB interface Plug the USB cable from your digital camera to print photographs 
directly from your camera.

3 Power connector Connector into which you plug the printer’s external power 
transformer or car lighter adapter, both of which provided in the 
product packaging. 
note: Plug the external power transformer into the printer first 
and then into the electrical outlet.

4 Carry handle Extract this handle to carry your printer wherever you go.

5 High-speed USB 
interface

Plug the USB cable (not included) used for connection to your 
personal computer. Plug the other end of the cable to the 
computer.

6 Paper cassette 
insertion slot

Insert here the 20-sheet paper cassette after sliding it off the rails 
on the bottom of your printer.

7 Memory card slots Insert your memory cards in these slots to read their contents and 
select the pictures that you want to print. See "Inserting and 
Removing Memory Cards". Can accommodate Compact Flash I, 
II, Microdrive, SmartMedia, SecurDigital and MultiMedia cards, 
Memory Sticks and xD-Picture cards.

8 Ink cartridge carrier Holds the colour ink cartridge. For information on how to change 
the ink cartridge, see "Replacing the Ink Cartridge".

9 Paper exit slot and 
paper jam clearing 
area

Slot from where the printed sheet of paper exits the printer. Also 
used for clearing paper jams inside the printer. For information on 
how to clear paper jams, see "Clearing Paper Jams".

10 Left inner cover Closes the paper exit slot and ink cartridge carrier.

11 Battery compartment Holds six 2-2.3 Ah rechargeable Nickel Cadmium (NiCd) or Nickel 
Metal Hydride (NiMH) batteries that power the printer when the 
external power transformer or car lighter adapter is not used.

12 Paper cassette Holds up to 20 sheets of 280 gm2 photo paper. When not used, 
the paper cassette can be secured underneath the printer.
GETTING STARTED 5
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PRINTER CONTROL PANEL 

The printer control panel allows you to manually control the printing of photos received from a digital 
camera connected to the printer, stored in a memory card inserted in one of the printer’s memory card 
slots, or received from a Bluetooth peripheral. With its colour display, you can also scroll and view the 
photos. This console also includes buttons by means of which you can select your photos and 
customise print jobs. The icons on the buttons illuminate to indicate the selection currently active.

4
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Reference Part Description

1 On/Off Button Turn your printer on or off.

2 Out of ink indicator Flashes or illuminates to indicate an out ink condition, in which 
case it is suggested that you replace the ink cartridge. See 
"Replacing the Ink Cartridge".

3 Paper error indicator • Illuminates to indicate an out of paper condition.
• Illuminates to indicate a paper jam. See "Clearing Paper 

Jams".
• Illuminates to indicate the feed of an incorrect paper size 

when printing. 

4 Page layout button Press to select the layout in which the photos will be printed on 
the paper. Press this button sequentially to select:
• the index of your pictures, which will be correctly printed if 

already compiled by the device (digital camera). If an index is 
not provided by the device, the printer will create its own 
index of pictures by it may not be complete.

• 4 borderless photos fitted on the page size
• 2 borderless photos fitted on the page size
• 1 photo with borders and fitted on the page size
• 1 borderless photo fitted on the page size
As you press this button, the icons illuminate to indicate the 
corresponding page layout selected. If the icons do not illuminate, 
there is no device connected to the printer. Borderless is not 
available when using plain A4 paper folded vertically in the 
middle.
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5 Select button Press to select the photo displayed on the LCD. 

6 Copy selection 
buttons

Press the Plus sign (+) button to increase the number of copies to 
be made, press the Minus sign (-) button to decrease the number 
of copies to be made. The number of copies selected is displayed 
on the lower right side of the picture.

7 Cancel button Press to immediately cancel a print job in progress, eject the paper 
and to return all settings to their default values.

8 Print button Press to print the photos selected. This button flashes during a 
print job.  

9 Navigation buttons Press the four direction buttons to navigate through the pictures 
stored on the storage device. The pictures are displayed on the 
LCD as you press the related button. Press and hold down to scroll 
through the different views. 

10 Change view button Press to toggle between full-screen and thumbnail picture views 
on the colour display. This button does not illuminate.

11 Colour display A 1.9", 65K colour Liquid Crystal Display (LCD) for previewing 
and selecting your pictures.

12 Bluetooth activity 
indicator

Illuminates when the printer is powered on, flashes when files are 
being transferred from the Bluetooth peripheral to the printer.

Reference Part Description
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LOADING PAPER

The printer is equipped with a paper detection sensor that automatically detects whether the paper is 
fed manually or from the paper cassette.

Loading Paper in the Paper Cassette

1 Open the paper cassette lid. Load up to 20 sheets of photo paper in the paper cassette bay with the 
print or glossy side facing upward, adjusting the paper width guide accordingly. Close the paper 
cassette lid.

2 Open the printer’s left outer door by pressing the upper centre part of the door to release it. Insert the 
paper cassette into the insertion slot and press it firmly until it clicks into place.

Loading a Single Sheet of Plain A4 Paper Folded Vertically in the Middle

You can manually load a single sheet of A4 plain paper folded vertically, corresponding to a double A6 
size format (105 x 297 mm). 

1 Make sure that your printer is turned on and that the paper cassette is inserted. See “Turning On Your 
Printer”.

2 Fold a sheet of plain A4 size paper vertically in the middle. Place the paper between the two paper 
guides on the top of the paper cassette and feed the leading edge of the sheet into the insertion slot 
until it is picked up by the printer’s feed mechanism. 
CHAPTER 1



POWERING YOUR PRINTER

Choosing the Power Source For Your Printer

You can power your printer from the mains electrical power supply by using the transformer provided, 
from your automobile battery by using the car lighter adapter provided, or with six 2-2.3 Ah 
rechargeable Nickel Cadmium (NiCd) or Nickel Metal Hydride (NiMH) batteries that you can purchase 
from electronic stores or from large retailers.
note: You can also order an Olivetti battery recharge kit by phoning a hot-line number listed in the 
leaflet that came with the printer, provided in the printer software or in the Olivetti web site.

Mains Electrical Power Supply
1 Insert the transformer power jack into the printer’s power socket, then insert one end of the power 

cord into the transformer and the other end to an electrical wall outlet. 

12V Car Battery Power Supply
1 Plug one end of the car lighter adapter into the printer power socket and the other end into your 

automobile’s cigarette lighter. 
GETTING STARTED 9
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Rechargeable NiCd or NiMH Batteries
1 Turn over your printer and then open and remove the battery compartment cover.
2 Insert six 2-2.3 Ah rechargeable Nickel Cadmium (Nicd) or Nickel Metal Hydride (NiMH) batteries in the 

battery compartment, then replace and close the compartment cover.

TURNING YOUR PRINTER ON AND OFF

Turning On Your Printer

Press the ON/OFF button on the printer control panel.  
The printer will execute a series of autodiagnostic tests aimed at detecting any possible system 
malfunction. Any error detected at this time will be signalled by the control panel, or by the personal 
computer if connected to the printer. See "Meaning of the Indicators on the Control Panel" for the 
corrective actions in case any error is detected. 

Upon the successful completion of the autodiagnostics, the printer’s idle screen is displayed on the 
control panel LCD.

When you connect a non-PictBridge digital camera to the printer or insert a memory card in the 
appropriate memory card slot, all of the icons on the control panel will illuminate. When you connect a 
PictBridge digital camera only the Print button will turn off to indicate that printing is controlled directly 
from the attached digital camera.

Turning Off Your Printer

To turn off your printer when you finished working with it, press the ON/OFF button on the control 
panel. All the lights on the control panel, and the LCD, will turn off.
CHAPTER 1



CONNECTING A DIGITAL CAMERA TO YOUR PRINTER

1 Turn on your digital camera. Read your camera’s User’s Guide for more information.
2 With your printer powered on, plug one end of the digital camera’s USB cable to the USB connector on 

the camera.
3 Open the printer’s left outer door by pressing the upper centre part of the door to release it. Plug the 

other end of the USB cable into the printer’s USB connector.
note: When you connect a PictBridge digital camera to your printer, the print icon on the control panel 
will turn off to indicate that printing will be controlled directly from the digital camera. Read your 
camera’s User’s Guide for instructions on how to print your photos.

INSERTING AND REMOVING MEMORY CARDS

Your printer can read the following memory storage devices: Compact Flash I, II, Microdrive, 
SmartMedia, SecurDigital and MultiMedia cards, Memory Sticks (Duo, Pro, Magic Gate) and xD-Picture 
cards.
note: Adaptors for reading Mini SD and MS Pro memory cards can be purchased separately.
Your printer can recognize and print the following file formats stored on the memory cards: DCF, JPEG, 
Extif and DPOF.

Inserting a Memory Card

Before inserting the memory card into its related slot, follow these insertion guidelines according to the 
card that you are using:
• When inserting a CompactFlash card, make sure that the label is facing upward (if the label has an 

arrow it needs to be pointing towards the printer) with the metal pinholes entering the printer first. 
• When inserting a Multimedia and SecureDigital cards, make sure that the angled corner is on the 

right and the metal contacts are facing downward.
• When inserting a SmartMedia card or a Memory Stick, make sure that the angled corner is on the 

right and the metal contacts are facing upward.
• When inserting a xD-Picture Card, make sure the curved side of the card is facing you and the metal 

contacts are facing downward.
note: It is important that you remember the correct orientation of the card when you insert it into the 
printer as inserting it any other way could damage the card and the printer.
GETTING STARTED 11



12
Proceed as follows:
1 Open the printer’s left outer door by pressing the upper centre part of the door to release it, so you 

can access the memory card slots. 
2 Orient your specific memory card as indicated at the beginning of this section, carefully insert it into the 

selected slot and then gently push it in until it stops. 
The following figure shows an example of the insertion of a Compact Flash card.
note: The memory card does not go in all the way; do not try to force it in since doing so will damage 
the card and the printer.

If the card is inserted correctly, an icon is displayed on the LCD indicating the total number of photos 
stored on the memory card (only the compatible files are opened and counted).

Removing a Memory Card

1 Carefully pull the card completely out of its slot. To remove a Compact flash card, push the extraction 
button located on the side of the insertion slot.
CAUTION: DO NOT remove the memory card while it is still being accessed either by the printer or 

personal computer. Doing so could damage the photos stored on the card.
CHAPTER 1



 CARRYING YOUR PRINTER

1 Extract the paper cassette from its insertion slot on the right side of the printer and close the printer’s 
left outer door.

2 Slide the paper cassette along the cassette rails on the bottom of the printer until it is locked in place by 
the securing clip.

3 Extract the handle on the top of the printer and carry the printer wherever you go.
GETTING STARTED 13
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2USING YOUR PRINTER 
WITHOUT A COMPUTER 

VIEWING PHOTOS ON YOUR PRINTER’S DISPLAY

SELECTING AND PRINTING PHOTOS FROM YOUR MEMORY CARD

PRINTING PHOTOS FROM YOUR PICTBRIDGE DIGITAL CAMERA

SELECTING AND PRINTING PHOTOS FROM YOUR DPOF DIGITAL CAMERA

SELECTING AND PRINTING PHOTOS FROM YOUR NON-PICTBRIDGE/DPOF DIGITAL CAMERA

PRINTING PHOTOS FROM A BLUETOOTH PERIPHERAL
USING YOUR PRINTER WITHOUT A COMPUTER 15



16
VIEWING PHOTOS ON YOUR PRINTER’S DISPLAY

Full-Screen Views

Navigating Through Full-Screen Views and Selecting Photos
1 To scroll through all the photos that are stored on the connected storage device and displayed in this 

screen view, press the Right and Left Navigation button.
2 To select the photo displayed and that you want to print, press the Select button.
3 To deselect the photo displayed, press the Select button again.

Reference Part Description

1 Browse window Displays the current photo.

2 Select frame Indicates the selection state, highlighted when the Select button 
is pressed to select the photo displayed.

3 Image Total field Indicates the number of selected photos that you want to print.

4 Device icon Represents the device connected. 

5 Icon bar The bar where the different icons reside.
CHAPTER 2



Thumbnail Views

SELECTING AND PRINTING PHOTOS FROM YOUR MEMORY CARD

1 Open the printer’s left outer door by pressing the upper centre part of the door to release it, then insert 
the memory card that you wish to print from into the related slot. The file transfer screen is displayed 
on the LCD indicating that your printer is reading the compatible files stored on the connected memory 
card.

2 A screen indicating the total number of compatible photos stored on the memory card is displayed on 
the control panel LCD. If needed, press the Change View button to toggle between full-screen and 
thumbnail screen views. See "Viewing Photos on Your Printer’s Display". An icon on the screen’s icon 
bar will indicate the device connected.

3 Using the Right, Left, Up, Down Navigation button, scroll through the photos to position the 
highlighted frame on the photo you wish to print.

4 Select the number of copies you want to print of the photos selected by pressing the plus (+) or minus 
(-) button. A copy indicator is displayed on the bottom-right corner of the photo selected to indicate 
the number of copies requested for that photo. The total number of photos selected is displayed on the 
icon bar on the bottom of the screen.

5 Select the layout in which you wish to print the selected photos by pressing the Page Layout button the 
number of times needed to select the required layout. You have the following possibilities: 
– Print an index sheet of all the photos if "All photos" was selected (by clicking on the icon showing 

the total number of photos stored on the memory card).
– Print 4 borderless photos fitted on the page size.
– Print 2 borderless photos fitted on the page size.
– Print 1 photo with borders and fitted on the page size.
– Print 1 borderless photo fitted on the page size.

6 Press the Print button to print the selected photos. The illuminated button icons will go off, the photo 
processing screen is displayed on the LCD. 

7

Reference Part Description

1 Photo indicator Indicates how many photos are stored on the connected device.

2 Select frame Indicates that the photo was selected by using the Select button. 

3 Browse frame Highlights the current image as a result of the of the pressing of 
the Navigation button.

4 Thumbnail grid A total of 9 grids where the photos are displayed in miniature 
format.

5 Image total field Indicates the number of photos that you want to print.

6 Device icon Indicates the device connected.

7 Icon bar The bar where the different icons reside.
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18
Upon completion of the print job, the initial screen indicating the number of photos stored will be 
redisplayed.

PRINTING PHOTOS FROM YOUR PICTBRIDGE DIGITAL CAMERA

1 Load the paper on which you want to print. For optimum results when printing photographs, use 
photo paper. For information see "Loading Paper".
note: If the size of the paper loaded in the printer is different than the paper size selected from the 
digital camera for printing and you begin to print, the printed output will be wrong. 
Only a paper size smaller than the size selected from the digital camera will interrupt the print job and 
cause the Print button on the control panel to illuminate. Load the correct paper and press the Print 
button to resume printing.

2 Make sure your PictBridge digital camera is turned on and connected to the printer. For more 
information, see "Connecting a Digital Camera to Your Printer".

3 Printing is managed directly by your camera, so read your camera’s User’s Guide for instructions on how 
to print your photos.
During printing, the Print button will flash to indicate that a print job is under way.

SELECTING AND PRINTING PHOTOS FROM YOUR DPOF DIGITAL CAMERA

Your printer is capable of recognizing the DPOF information associated to picture files. In the case of a 
DPOF digital camera, the printer will print the photos that you select directly from your camera. 
note: Before proceeding, make sure that your digital camera is DPOF-complaint by reading the 
camera’s User’s Guide. 

1 Load the paper on which you want to print. For best results when printing photographs, use photo 
paper. For information see "Loading Paper".
If the size of the paper loaded in the printer is different than the paper size selected from the digital 
camera for printing and you begin to print, the printed output will be wrong. 
Only a paper size smaller than the size selected from the digital camera will interrupt the print job and 
cause the Print button on the control panel to illuminate. Load the correct paper and press the Print 
button to resume printing

2 Make sure your DPOF digital camera is turned on and connected to the printer. For more information, 
see "Connecting a Digital Camera to Your Printer".

3 If you associated DPOF information to the photo files stored in your camera’s memory, the printer will 
automatically print the photos that you have selected. Read your camera’s User’s Guide for instructions 
on how to select the photos you want to print.

4 If you did not associate DPOF information to the photo files, a screen indicating the total number of 
photos stored in the digital camera’s memory is displayed on the control panel LCD. If needed, press 
the Change View button to toggle between full-screen and thumbnail screen views. See "Viewing 
Photos on the Control Panel LCD" for information regarding the views and indications displayed on the 
LCD. An icon displayed on the screen’s icon bar will indicate the device connected.

5 Using the Right, Left, Up, Down Navigation button, scroll through the photos to position the 
highlighted frame on the photo you wish to print.

6 Select the number of copies you want to print of the photos selected by pressing the plus (+) or minus 
(-) button. A copy indicator is displayed on the bottom-right corner of the photo selected to indicate 
the number of copies requested for that photo. The total number of photos selected is displayed on the 
icon bar on the bottom of the screen.

7 Select the layout in which you wish to print the selected photos by pressing the Page Layout button the 
number of times needed to select the required layout. You have the following possibilities: 
– Print an index sheet of all the photos if "All photos" was selected (by clicking on the icon showing 

the total number of photos stored on the memory card).
– Print 4 borderless photos fitted on the page size.
– Print 2 borderless photos fitted on the page size.
– Print 1 photo with borders and fitted on the page size.
– Print 1 borderless photo fitted on the page size.

8 Press the Print button on your printer’s control panel to print your photos. For more information see 
“Printer Control Panel”.
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SELECTING AND PRINTING PHOTOS FROM YOUR NON-PICTBRIDGE/DPOF DIGITAL CAMERA

1 Load the paper on which you want to print. For optimum results when printing photographs, use 
photo paper. For information see Loading Paper".

2 Make sure your digital camera is turned on and connected to the printer. For more information, see 
"Connecting a Digital Camera to Your Printer".

3 A screen indicating the total number of photos stored in the digital camera’s memory is displayed on 
the control panel LCD. If needed, press the Change View button to toggle between full-screen and 
thumb-nail screen views. See "Viewing Photos on the Control Panel LCD" for information regarding 
the views and indications displayed on the LCD. An icon displayed on the screen’s icon bar will indicate 
the device connected.

4 Using the Right, Left, Up, Down Navigation button, scroll through the photos to position the 
highlighted frame on the photo you wish to print.

5 Select the number of copies you want to print of the photos selected by pressing the plus (+) or minus 
(-) button. A copy indicator is displayed on the bottom-right corner of the photo selected to indicate 
the number of copies requested for that photo. The total number of photos selected is displayed on the 
icon bar on the bottom of the screen.

6 Select the layout in which you wish to print the selected photos by pressing the Page Layout button the 
number of times needed to select the required layout. You have the following possibilities: 
– Print an index sheet of all the photos if "All photos" was selected (by clicking on the icon showing 

the total number of photos stored on the memory card).
– Print 4 borderless photos fitted on the page size.
– Print 2 borderless photos fitted on the page size.
– Print 1 photo with borders and fitted on the page size.
– Print 1 borderless photo fitted on the page size.

7 Press the Print button on your printer’s control panel. The photos stored in the memory of your camera 
will be printed. 

PRINTING PHOTOS FROM A BLUETOOTH PERIPHERAL

Your printer is equipped with an integrated Class 2 Bluetooth component. 
Its default address is 0000 so it can directly print any .JPEG transmitted from a Bluetooth mobile phone 
or personal computer located within a maximum distance of 10 meters from the printer.
note: You can change your printer’s default Bluetooth address from your personal computer, if 
connected to the printer.

1 Make sure that paper is loaded in the printer. For information see "Loading Paper".
2 Turn on your printer. See "Turning On Your Printer". Bluetooth capabilities are automatically activated 

on your printer.
3 Turn on the Bluetooth peripheral that you want to print from and, from within a distance of 10 meters 

from the printer, launch a Bluetooth discovery procedure directly from your peripheral. By activating 
this procedure, your Bluetooth peripheral will search for another Bluetooth device in the vicinity (in this 
case, your printer) with which it can share data. For information on how to launch a Bluetooth 
discovery procedure, read your peripheral’s User’s Guide.

4 When your Bluetooth peripheral has discovered your printer, launch the print job directly from your 
Bluetooth device. For instructions, read your peripheral’s User’s Guide.
The Bluetooth icon on the control panel will flash as the photos are being transferred from the 
Bluetooth device to your printer for printing. The photos will be printed without borders, or with 
borders if plain A4 size paper folded in the middle is loaded.
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BEFORE YOU BEGIN

This chapter outlines the basic operating information that will put you in the condition to start using 
your printer when connected to a computer. 
Before you begin:

1 Make sure that your printer and personal computer are connected properly and that the software on 
the “Installation" CD-ROM was successfully installed on the computer as indicated in the Setup 
Diagram provided with your printer.

2 Load the paper on which you want to print. For more information see “Loading Paper".
3 Make sure that the out of ink indicator on the control panel is not flashing, or not illuminated. If it is, it 

is suggested that you replace the ink cartridge. For more information see “Replacing the Ink 
Cartridge".

THE TOOLBOX

The Toolbox application allows you to control printing operations directly from a single user interface 
on your computer monitor. 
Included in the “Installation" CD-ROM, the Toolbox is installed automatically on your computer when 
you install the software contained on this CD-ROM. 
To access the Toolbox:

1 Right click your mouse button on the Olivetti icon on the Windows task bar and click on MY_WAY 
Toolbox, or click Start > Programs or All Programs > Olivetti > MY_WAY Toolbox. The Toolbox is 
displayed.

The main area of the Toolbox includes the icons representing the different tools available. 

Clicking on this 
Toolbox icon:

You can:

Print photos • Browse your computer’s hard disk, the memory of the non-Pictbridge/DPOF 
digital camera connected to your computer or the memory card inserted in your 
printer to search for the folder containing photos to print.

• Select all the photos stored in the folder or just the individual ones wanted, and 
choose how may copies to print.

• Select the type of paper to print on, and its size.
• Select whether to print the photos on a single page, two on one page or four 

on one page.
• Print an index sheet of photos.
• Print the photos you have selected. 

Memory card file 
transfer

• Transfer the contents of the memory card inserted in the printer to a folder on 
your computer. See "Transferring Files from Memory Card to your Computer".
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The Toolbox main interface screen also provides links to Help, Solutions and assistance, and Settings.

THE PRINTER STATUS MONITOR

The Printer Status Monitor provides information on the current state of your printer. It is installed 
permanently on your computer when you install the software contained on the "Installation" CD-ROM. 
Displayed automatically at the beginning of a print job, the Status Monitor:

• displays a graphical representation of the percentage of the print job already completed.
• displays the page number being currently printed out of the total number of pages of the job.
• displays the job title.
• displays a graphical representation of the estimated amount of ink, in percentage, still available in the 

cartridge.
• allows you to cancel the print job.
• provides you with the address of the manufacturer’s web site, where you can access the information 

needed to purchase new ink cartridges.
The Status Monitor closes automatically at the end of the print or copy job, but you can close it to its 
icon on the Windows task bar at any time.
If you decide to close the Status Monitor during a print or copy job, it will be automatically redisplayed 
in the following conditions:

• when the ink remaining in the cartridge is low, or when the cartridge is out of ink. A coloured 
exclamation mark will indicate when the cartridge in a low ink condition and the importance of the 
condition. Pop-ups will be displayed with the address of the manufacturer’s web site, where you can 
access the information needed to purchase a new ink cartridge.
The Printer Status Monitor also displays error pop-ups when:

• your printer runs out of paper.
• a paper jam has occurred.
• your printer is busy with another task.
• your printer is not recognised.
• the ink cartridge carriage is jammed.
• your printer does not work (printer error).

In all of the above error conditions, you can choose whether to continue or cancel the print job by 
clicking the related button on the screen.

Clicking on this 
Toolbox link:

You can:

Help • Read more information on the currently displayed topic.

Solutions and 
assistance

• Clean and test the ink cartridge. 
• Automatically align the ink cartridges. See "Aligning the Ink Cartridge From the 

Toolbox".
• Find the address of the manufacturer’s web site, where you can access the 

information needed to purchase new ink cartridges.
• Access troubleshooting information.
• Access contact information.

Settings • Change the Toolbox default settings.
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PRINTING 

Printing From Your Application Using Print Properties

1 With the document or photo open in the application that you are using, click File > Print to open the 
Print dialogue box.

2 Click Preferences or Properties, depending on your operating system. 
3 On the Paper/Quality tab, customise your print settings:

a Document type: define the characteristics of the document that you want to print. Select Auto 
detection to have the printer automatically detect the characteristics of the document or Manual 
selection to manually define the characteristics yourself. 
If you select Manual selection, choose the characteristics of the document to be printed: Text 
(black text or line art only), Mixed (combination of black text or line art and colour graphics or 
photos), or Photo (colour photos only).

b Paper Setup: from the drop-down menus available, select the type of paper that you want to use 
(Plain, Coated, Photo, Glossy, Cards) and its size. 
• If you select Coated, Glossy, or Cards as the type of paper you will be using, the Borderless 

checkbox is displayed so you can choose to print without borders. 
• If you select Photo paper as your paper type, by default the Borderless checkbox will be 

selected enabling you to print borderless photos on the selected media.
• If plain paper is selected the Manual Feed checkbox is already selected. In this case the printer 

will not begin to print until you load the paper, and will automatically recognise the size of the 
paper loaded. Plain A4 size paper folded in the middle can be fed only manually from the top of 
the paper cassette.

note: If you load paper that is smaller than the selection made, the printer will eject the paper 
prompting you to load paper corresponding to the selected size.

c Quality: define the quality of your printed output. Select between Speed (highest print speed, 
lowest resolution), Normal (average print speed and resolution), High (low print speed, high 
resolution) and Photo Quality (lowest print speed but with the highest print resolution).
• You can also select to print in Colour or in B/W (Black and white). By default the Colour radio 

button is always checked, enabling full-colour printing. Select B/W when you need to print 
shades of grey, or to continue to print when the colour cartridge is out of ink.

d By default, the Print Last Page First checkbox is selected so upon completion of the print job the 
first page of your multiple-page document remains on top of the document. Click this checkbox to 
deselect it if you want to print starting from the first page of your document. 

e In the No. Copies box, use the up or down arrows to define the number of copies you want to 
print.

f To return the different screen settings to their factory default values, click the Default button.
g On the bottom of the screen:

• Click the OK button con confirm the settings made and exit. 
• Click the Cancel button to exit without saving the changes made. 
• Click the ? button for information on the Paper/Quality tab.

4 Click the Layout tab to select the layout format of your printed output:
a The Single page per print radio button is selected by default. Your printer will print the individual 

pages of the document, or your photos, on a single page layout. 
b Click the Multiple pages per print radio button to fit the selected number of pages on a single 

sheet of paper. By selecting this option:
• The Pages per print drop-down menu is displayed where you can select to print either 2, 3, 4 

or 8 pages of your document on a single sheet.
• The Order drop-down menu is then displayed where you can select the order in which the 

multiple pages will be fitted on the single sheet of paper. You can select between Left-to-right 
down, Right-to-left down, Right-to-down left or Left-to-down right, depending on the 
number of pages selected.

• By clicking the Borders checkbox, a frame is placed around the individual page images on the 
single sheet of paper.

c Click the Poster radio button to expand the contents of a single page onto more than one sheet of 
paper. The final output consists of your selected poster image distributed among the number of 
pages defined:
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• The Poster drop-down menu is displayed where you can select 2x1, 2x2, 3x3 or 4x4 to define 
on how many sheets to fit the selected poster image.

• By clicking the Print Borders checkbox, the printer will automatically place a frame around 
each individual image that your poster is composed of. An indication of the position of the 
image in the poster is also provided.

d To restore the different settings to their factory default values, click the Default button.
e On the bottom of the screen:

• Click the OK button to confirm the settings made and exit.
• Click the Cancel button to exit without saving the changes made.
• Click the ? button for information on the Layout tab.

5 Click the Ink Levels tab to see the estimated amount of ink still available in the ink cartridge. This is 
important information to consider before launching a lengthy print job.
a On the Ink Levels tab there is also the Launch Toolbox button, a direct link to the Toolbox 

Maintenance screen that provides a user interface for the maintenance and troubleshooting of 
your printer. See "The Toolbox" for more information.

b On the bottom of the Ink Levels tab:
• Click on the OK or Cancel button to exit.
• Click on the ? button for information on the Ink Levels tab.

6 Click the OK button in the Print dialogue box to start printing.

Printing with the Toolbox Print Photos Tool

1 Right click your mouse button on the Olivetti icon on the Windows task bar and click MY_WAY 
Toolbox, or click Start > Programs or All Programs > Olivetti > MY_WAY Toolbox. The Toolbox is 
displayed.

2 Click Print photos. The "My pictures" folder of your personal computer is opened by default if a 
digital camera is connected; if a memory card is inserted, the folder with the contents of the memory 
card is opened by default. 
note: The printer directly prints the picture files stored on the memory card and therefore do not 
remove the memory card from its slot while connection is in progress.

3 The pictures stored in the folder are displayed in thumbnails on the left of the dialogue box; the first 
photo of the folder, or the photo that you click on, is displayed in a larger view on the right of the 
screen. You can now select what to do:
a Click the Add All button to add all the photos in the folder to your selection of photos to print.
b Select the individual photos to print by clicking directly on the photo wanted. Define the number of 

copies that you want to print of the photo selected by clicking on the plus (+) and minus (-) boxes 
that appear on the selected photo. You can also select the number of copies by clicking on the copy 
selection arrows on the bottom of the screen. The box on the upper part of the selected photo 
indicates the number of copies chosen. Use the box’s side scroll bar or arrow buttons to move up 
and down through the selection of photos available.
note: To remove all the photos from your print selection, click the Clear Selection button. To 
remove single photo selections, click on the minus (-) box on the individual photos, or click the copy 
selection arrows on the bottom of the screen, to decrease the number of copies to zero. 

4 Click the Print button. The Print Photos dialogue box is displayed.
5 Personalise your print settings:

a Paper setup: from the drop-down menu select the paper that you loaded and define its size.
b Quality: define the quality of your printed output. Select between Speed (highest print speed, 

lowest resolution), Normal (average print speed and resolution), High (low print speed, high 
resolution) and Photo Quality (lowest print speed but with the highest print resolution).

c Select Layout: choose the layout that you prefer by clicking on the graphical representation of one 
of the following options: Full Page, Two-in-One, Four-in-One and Index.
note: The Borderless layout is not available if Plain paper type is selected.
note: When the Two-in-One paper layout, if an A6 paper size is chosen, the printer will print two 
wallet-sized pictures. When a Four-in-One paper layout is selected, if an A6 paper size is chosen, 
the printer will print four passport sized pictures. When selecting an Index layout, all of the pictures 
will be bordered. 
note: When selecting an Index layout, all of the pictures will be bordered.

6 Click the Print button to start printing. 
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TRANSFERRING FILES FROM A MEMORY CARD TO YOUR COMPUTER

1 Insert into the corresponding slot on the printer, the memory card containing the files to transfer. See 
"Inserting and Removing Memory Cards".

2 Right click your mouse button on the Olivetti icon on the Windows task bar and click MY_WAY 
Toolbox, or click Start > Programs or All Programs > Olivetti > MY_WAY Toolbox. The Toolbox is 
displayed.

3 Click the Memory Card File Transfer icon.
4 Click the Browse button and search for the folder on your computer in which to transfer the files.
5 Click the OK button once you have found the folder wanted.
6 Click the Transfer button to start the file transfer from the memory card to your computer.

note: To cancel the file transfer and return to the Toolbox’s main screen, click the Cancel button. For 
information, click Help.
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CHECKING INK LEVELS

To know when the ink cartridge is running out of ink and needs replacing, check the ink levels in the 
following ways:

1 By viewing the ink level indicators on the Ink Levels tab of your print driver’s Preferences or Properties 
dialogue box, as follows:
a With the document file open in the application that you are using, click File > Print. The Print 

dialogue box is displayed.
b Click Preferences or Properties, depending on your operating system. The printer driver user 

interface screen is displayed.
c Click the Ink Levels tab. The ink capacity indicator shows the percentage of ink remaining in the 

cartridge. 
2 From the Toolbox, by viewing the ink level indicators on the bottom of the Toolbox’s main screen or in 

the New ink cartridges dialogue box:
a Right click your mouse button on the Olivetti icon on the Windows task bar and click MY_WAY 

Toolbox, or click Start > Programs or All Programs > Olivetti > ANY_WAY Toolbox. The 
Toolbox is displayed.

b Click Solutions and Assistance.
c Click Select to choose New ink cartridges. The New ink cartridges dialogue box displayed includes 

the ink level indicator showing the amount of ink remaining in the cartridge. 
3 From pop-ups displayed by the Printer Status Monitor during a print job, that show the amount of ink 

remaining. See "The Printer Status Monitor" for more information.
4 From the Start menu:

a Click Start > Programs or All programs > Olivetti > MY_WAY New ink cartridge. The Status 
Monitor is displayed.

5 Directly on the printer control panel:
a When the ink indicator begins to flash, the ink level in the cartridge is getting low; when the 

indicator is on steady, the ink cartridge is almost out of ink.
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REPLACING THE INK CARTRIDGE

Before proceeding with the procedures indicated in this section, carefully read and follow the 
information provided in "Safety Instructions" at the beginning of this manual.
For information on how to purchase new ink cartridges from the manufacturer, consult the Toolbox’s 
Solutions and Assistance feature. To access the Toolbox, see “The Toolbox”. To guarantee the correct 
operation of your printer and top quality printing, it is essential to use only the manufacturer’s original 
ink cartridges.

1 Turn on the printer. 
2 Make sure that paper is loaded. See "Loading Paper".
3 Open the printer’s right outer door by pressing the upper centre part of the door to release it, then pull 

open the printer’s right inner door. The ink cartridge carrier moves to its loading position at the far 
right-hand side of the carriage.

4 With your index finger, pull and rotate downward the top edge of the ink cartridge and remove it from 
the carrier.
.

5 If you are installing a new ink cartridge, remove the cartridge from its box and then gently remove the 
protection tape that covers the ink nozzles. DO NOT TOUCH THE CONTACTS or the ink nozzles. Hold 
the ink cartridge by its sides.
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6 Hold the ink cartridge with its nozzles facing downward and its contacts facing the rear of the printer, 
then insert the cartridge into the carrier from the bottom nozzle side first and with a rotating motion.

7 Push the ink cartridge firmly until it clicks into place.

8 Close the printer’s inner and outer doors.

9 If a new cartridge is installed, the printer will automatically perform a cartridge recognition procedure 
which lasts at least 3 minutes. An ink cartridge alignment page will then be printed to indicate that the 
newly installed ink cartridge was automatically aligned. For information see "Aligning the Ink 
Cartridge".
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ALIGNING THE INK CARTRIDGE

The ink cartridge is automatically aligned by the printer whenever a new cartridge is installed.
However, you need to manually align the ink cartridge when the edges of the printed characters are 
still not clear, or when the lines still appear wavy, even after cleaning the ink cartridge nozzles. See 
“Aligning the Ink Cartridge From the Toolbox”.

Aligning the Ink Cartridge From the Toolbox

When the edges of the printed characters are still not clear, or when the lines still appear wavy, even 
after cleaning the ink cartridge nozzles:

1 Right click your mouse button on the Olivetti icon on the Windows task bar and click on MY_WAY 
Toolbox, or click Start > Programs or All Programs > Olivetti > MY_WAY Toolbox. The Toolbox is 
displayed.

2 Click Solutions and Assistance and then Select the "Print the alignment page" option.
3 Click the Print button.
4 When the alignment page is printed, the ink cartridge has been aligned. Click Close to return to the 

Toolbox main screen.
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CLEANING YOUR PRINTER

CAUTION: Do not clean the inside of your printer and do not use stain removers, acetone-based 
products, liquid or aerosol cleaners. Doing so could damage your printer case.

Cleaning the Printer Casing

1 Clean the printer casing by using a soft dry cloth or moistened in warm water to wipe dust, dirt or 
smears off the outer case of your printer only.

CLEANING THE INK CARTRIDGE NOZZLES

Clean the ink cartridge nozzles when:
• White or colour lines appear in your printouts.
• Colours fade, or do not print in parts or completely.
• The vertical lines of your printout are jagged.

To clean the ink cartridge nozzles:
1 Make sure paper is loaded in the printer. See "Loading Paper".
2 Right click your mouse button on the Olivetti icon on the Windows task bar and click on MY_WAY 

Toolbox, or click Start > Programs or All Programs > Olivetti > MY_WAY Toolbox. The Toolbox is 
displayed.

3 Click Solutions and Assistance.
4 Select the "Clean and Test Nozzles" option.
5 Click the Print button. The printer automatically cleans the nozzles and prints a test page.
6 Check the quality of the printed output with the example displayed on the computer monitor. If you 

are not satisfied with the quality of the printed output, click the Clean again button to repeat the 
nozzle cleaning procedure.

7 When finished, click the Close button to return to the Toolbox main user interface screen.
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TROUBLESHOOTING

Problems During Printer Setup

Before reading this section:
1 Make sure the printer’s power transformer is properly connected to the printer and to a 

working electrical outlet, or the car cigarette lighter adapter is properly connected, or the six 
rechargeable 2-2.3 Ah Nickel Cadmium (NiCd) or Nickel Metal Hydride (NiMH) batteries are properly 
inserted and fully charged.

2 If you are using your printer with a personal computer, make sure that you have turned on both your 
printer and computer. 

3 Make sure the computer’s operating system is Windows 98 SE, ME, 2000 or XP, or MAC OS 10.3 or 
later.

Problem Possible Cause Corrective Action

Your printer does not turn on. • Refer to the “Problems When 
Powering On the Printer” 
paragraph on the following 
pages.

You insert the “Installation”
CD-ROM into your computer CD 
drive and the installation 
program does not start 
automatically. 

• An operating system 
incompatible with the CD-
ROM software may be 
running on the personal 
computer.

1 Make sure the personal 
computer is running 
Windows 98 SE, ME, 2000 or 
XP, or MAC OS 10.3 or later.

• The auto-run feature is 
disabled.

• Your personal computer 
cannot find setup.exe on the 
CD-ROM.

1 Remove and replace the 
“Installation” CD-ROM in the 
CD drive with the written 
label upwards.

2 Select Start > Run and then 
click Browse.

3 Find the CD-ROM drive 
identifier and click Open.

4 Select Setup and click Open. 
The file setup.exe is displayed 
in the dialogue box.

5 Click OK and then follow the 
instructions displayed

Your printer’s name is not 
available when you select File > 
Print from an application. The 
printer is not shown in the 
Printer folder on the Control 
Panel.

• The printer driver was not 
installed correctly

1 Close all applications 
currently open.

2 Reinstall the printer software 
as instructed by the Setup 
Diagram or as indicated in 
the step above.

When connecting the printer to 
the computer with the USB 
cable, the Plug and Play wizard 
did not terminate.

• The computer did not find 
the printer driver.

1 Remove the “Installation” 
CD-ROM from the drive and 
re-boot the computer.

2 Place the “Installation” CD-
ROM in the drive with the 
written label facing upwards.

3 Reinstall the printer software 
as instructed in the Setup 
Diagram or as indicated in 
the step above.
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When connecting your printer to 
the computer with the USB 
cable, the New Hardware Wizard 
is not displayed on the 
computer’s monitor.

• The computer is running an 
incompatible operating 
system.

1 Make sure the computer is 
running Windows 98 SE, ME, 
2000 or XP, or MAC OS 10.3 
or later.

• The USB cable may not be 
properly connected between 
the printer and computer.

1 Turn off your printer and 
computer, then unplug the 
USB cable from these two 
devices.

2 Reattach the USB cable to 
the two devices by following 
the instructions in the Setup 
Diagram. Turn on the printer 
first followed by the 
computer.

• The computer may not be 
enabled for USB operation.

1 Click Start > Settings > 
Control Panel.

2 Double click on the System 
icon.

3 Click on the Device 
Manager or Hardware tab, 
then click on the Device 
Manager button.

4 Click the Plus (+) sign next to 
the USB (Universal Serial Bus) 
Controller option.
– If USB host controller and 

USB root hub are present, 
the USB is enabled.

– If they are not present, 
read your computer 
manual for information 
on how to enable a USB 
connection.

Problem Possible Cause Corrective Action
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Problems When Powering On the Printer

Problem Possible Cause Corrective Action

The printer does not turn on 
when you press the Power 
ON/OFF button on the control 
panel.

• When the printer is 
powered from the mains 
through its transformer:
The transformer’s power cord 
is not properly attached to 
the printer and/or not 
properly plugged into a 
working electrical outlet.

1 Unplug the transformer’s 
power cords from the printer 
and from the electrical outlet 
and then plug them back in.

2 If the ON/OFF button is not 
illuminated make sure that 
the electrical outlet is 
working by attaching 
another appliance that you 
know works into it and then 
turn on the appliance.

• When the printer is 
powered from the car 
battery through the car 
lighter adapter:
The car lighter adapter is not 
properly attached to the 
printer and/or to a working 
car cigarette lighter socket.

1 Unplug the cigarette lighter 
adapter from the printer and 
from the car socket and then 
plug it back in.

2 Make sure that the car 
cigarette lighter socket is 
working by attaching 
another device (such as a 
mobile phone) that you 
know works into it and then 
turn on the device.

• When the printer is 
powered by rechargeable 
batteries:
Six fully charged 2-2.3 Ah 
Nickel Cadmium (niCd) or 
Nickel Metal Hydride (NiMH) 
batteries are not inserted, or 
the batteries are not fully 
charged.

• Remove and reinsert the 
batteries correctly, or 
recharge the batteries.

Individual indicators on the 
control panel come on.

Specific printer error as signalled 
by the indicator.

• Check the corrective action 
for the corresponding 
indicator that is explained in 
"Meaning of the Indicators 
on the Control Panel".
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Printing Problems

Meaning of the Indicators on the Control Panel

Problem Possible Cause Corrective Action

Your printer does not print when 
you click on the Print icon on the 
task bar of the application you 
are using.

• Your printer is not set as the 
default printer.

1 Click Start > Settings > 
Printers.

2 Right-click on your printer’s 
icon and select Set as 
Default.

• Your printer is not properly 
connected to the computer.

1 Turn off your printer and 
computer, and then unplug 
the USB cable from these 
two devices.

2 Reattach the USB cable, then 
turn on the printer first 
followed by your computer.

The printing stops in the middle 
of a print job.

• The paper is jammed. 1 Clear the paper jam. See 
"Clearing Paper Jams".

2 Press the Cancel button to 
reset the error condition. The 
print job continues from the 
next page.

Horizontal streaks are printed. • The ink cartridge is dirty. • Clean the ink cartridge. See 
"Cleaning the Ink Cartridge 
Nozzles".

The printed characters are not 
properly defined.

• The ink cartridge is no longer 
aligned.

• Align the ink cartridge from 
your computer. See 
"Aligning the Ink Cartridge 
From the Toolbox".

Problem Possible Cause Corrective Action

The out of ink icon on the 
control panel is flashing.

• The ink cartridge is almost 
out of ink.

• You can continue to print 
until the icon is illuminated.

The out of ink icon on the 
control panel is illuminated.

• The ink cartridge is out of 
ink.

• Replace the ink cartridge. For 
information, see "Replacing 
the Ink Cartridge".

The paper error icon on the 
control panel is illuminated.

• You launched a print job and 
there is no paper loaded in 
the printer.

• Load paper. For information 
see "Loading Paper".

• The size of the paper that is 
loaded does not match the 
paper size that you selected 
from the Toolbox application 
or from the PictBridge-
compliant digital camera 
connected to the printer.

• Load the correct paper. For 
information see "Loading 
Paper".

• A paper jam has occurred. • Clear the paper jam. For 
information see "Clearing 
Paper Jams".
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CLEARING PAPER JAMS

1 Open the printer’s right outer door by pressing the upper centre part of the door to release it, then pull 
open the printer’s right inner door.

2 Firmly grasp the jammed paper and gently pull it out from where it jammed. If the paper tears, make 
sure you remove all the torn pieces from the printer.

3 Close the printer’s left inner and outer doors.
4 Press the Cancel button on the control panel to clear the error condition.

note: If the paper jam occurred when printing without a computer, the print job will continue from the 
next page. 
If the jam occurred when using a computer, the pop-up screen displayed allows you to either continue 
to print from the next page or to cancel the print job. 
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GENERAL SPECIFICATIONS

PRINTER SPECIFICATIONS

PAPER SPECIFICATIONS
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GENERAL SPECIFICATIONS

General Specifications

Display 1.9" colour Liquid Crystal Display for photo 
preview and selection.

Dimensions and weight • Height: 90 mm
• Width: 220 mm
• Depth: 162 mm
• Weight: 1.6 Kg

Power source • Power transformer plugged into a 100 - 240 
Vac, 50-60 Hz electrical outlet.

• Car cigarette lighter adapter plugged into a 
12V automobile cigarette lighter.

• Six 2-2.3 Ah rechargeable Nickel Cadmium 
(NiCd) or Nickel Metal Hydride (NiMH) 
batteries. 

Power consumption Maximum 35 W

Connectivity • High-speed USB 2.0 interface for the 
connection of a personal computer.

• PictBridge-compliant USB 1.1 for the 
connection of a digital camera.

Wireless Interface • Bluetooth 1.2 Class 2 for connection to 
compatible PCs and mobile phones (Bluetooth 
model only).

Memory card interfaces Can accept the following memory card types:
• Compact Flash I, II
• Microdrive
• SmartMedia
• SecureDigital (Mini SD adaptor sold separately)
• MultiMedia card
• Duo, Pro, Magic Gate Memory Sticks 
• (MS Pro adaptor sold separately)
• xD-Picture card

Paper feed • Automatic sheet feeder from a paper cassette 
capable of holding up to 20 sheets of 280gr/m2 
photo paper

• Manual feed of a single sheet of plain A4 paper 
folded vertically in the middle

Temperature ranges • Operating: 15 °C to 35 °C
• Storage: -5 °C to +45 °C (without the ink 

cartridge) 
• Transportation: -15 °C to +55 °C

Humidity ranges • Operating: 15% to 85%, non-condensing
• Storage: 15% to 85%, non-condensing
• Transportation: 5% to 95%, non-condensing

Software and documentation • Printer driver (WIN/MAC)
• Toolbox (WIN/MAC)
• User Documentation (WIN/MAC)
• Additional software (WIN)
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PRINTER SPECIFICATIONS

PAPER SPECIFICATIONS

Supported Paper Types

Minimum system requirements for the connected 
personal computer

Operating system: 
• Microsoft Windows 98 SE, ME, Pentium II 500 

MHz, 128 MB RAM, 150 MB HDU
• Microsoft Windows 2000, Pentium III 650 MHz, 

128 MB RAM, 200MB HDU
• Microsoft Windows XP, Pentium III 650 MHz, 

256 MB RAM, 200MB HDU
• MAC OS 10.3 Power PC G4, 256 MB RAM, 

500 MB HDU

Supported files type DCF, JPEG, Exif, DPOF

General Specifications

General Specifications

Printing technology Bubble ink-jet

Printing system One, disposable 3-colour ink cartridge

Print resolution • 1200 x 1200 dpi
• 4800 x 1200 dpi
• 1200 x 600 dpi (text-based documents only 

received from a computer)

Print speeds • 1 page/90 sec, very high quality resolution on 
A6 size photo paper

• 1 page/60 sec, high quality resolution on A6  
size plain paper

Margins Borderless on photo, coated and glossy paper

Paper type Paper weight Maximum feed capacity

10x15 / 4"x6" and A6 Coated 
paper 

100 to 170 g/m2 20 sheets

10x15 / 4"x6" and A6 Glossy 
paper 

160 to 180 g/m2 20 sheets

10x15 / 4"x6" and A6 Cards 
paper 

130 to 280 g/m2 20 sheets

10x15 / 4"x6" and A6 Photo 
paper 

170 to 280 g/m2 20 sheets

Dual A6 (A4 Plain paper sheet 
folded vertically in the middle)

80 to 90 g/m2 Single sheet manual feed
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Supported Paper Formats and Sizes

note: All of the above paper sizes are automatically detected by the printer.

Format Size
4x6" cards 102 x 152 mm

A6 cards 105 x 148.5 mm

Dual A6 (Folded A4) 105 x 297 mm

10 x 15 cards 105 x 150 mm
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